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Discovery Question

What happens when two objects collide?

Introduction

In this activity you will investigate what happens during a collision of a cart with a
wall.
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Thinking About The Question

What happens when two objects collide?

Collisions happen so fast that it's hard to see what was going on during the event.
You just see the results of a smashed car or a home run or a sore hand. Sometimes
you want big forces, as with a baseball bat or a karate chop, and sometimes you
want to decrease the forces, as with a safety helmet.

In this activity you will use the Force probe to actually measure what happens
during a collision. How big are the forces? How long do they last? What features of
the colliding objects make the forces bigger or smaller? How would you increase or
decrease the forces during a collision? Write or draw in Notes on your handheld
computer your ideas about how to do this.
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Materials

• CC SmartWheel probe

• CC Force probe

• handheld computer

• CC LabBook software

• long rubber band or several cut rubber bands and joined together (so when they
are cut and joined it has a length of 1/2m)

• constructed air cart (see Investigation: Air Cart)

• books or (optional) a ring stand
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Safety

• Be careful with stretched rubber bands. They can hurt if you let them go and
they hit someone!

• The fan that is mounted on the air cart can hurt fingers when it is powered by the
battery, so watch out for your fingers!
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Trial I: Weighing the cart with the Force probe

1. The Force probe can be used to measure the force of the Earth's gravity on
masses. In other words, the Force probe can be used to measure the weight of
masses. Connect the Force probe to your handheld computer. Refer to
Technical Hints to see how to connect the cables.

2. Start the software.

3. Hold the Force probe so that you can hang things from the smaller eye bolt at
the end of the arm. Set the force probe to zero in this position. Refer to
Technical Hints to see how to set the Force probe to zero.

4. Try weighing something light, such as a pen hooked on with a paper clip.
Expand the force scale so that you can see the change in weight. What is the
smallest weight that you can measure?

5. Clear the graph and change the y-axis scale to read from 0 to 20N. Weigh
something heavier, like a book. Note that the units are in newtons, not
kilograms. What is the difference between newtons and kilograms? Explain your
reasoning in Notes on your handheld computer.

6. Use a paper clip to make a hook so that you can hang the cart from the Force
probe. It can be hooked to the bumper, around the propeller, or through the
cardboard.

7. Clear the graph. Start recording with the software for force. Hang the cart from
the Force probe for 10 seconds. Remove it and check that the force goes back
to zero. Stop recording and save your data.
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8. What was the average value for the weight of the cart? How steady was your
reading? How much did it vary and why?

9. If you hang the cart with a rubber band and weigh it, will it be the same? Try
it.

10. What variations do you get? Can you get a steady reading?

11. Calculate the mass, in kilograms, of your cart. The conversion is mass (kg) =
weight (newtons) / 9.8 What are the weight and the mass? Record your
answers on Notes in your handheld computer.

12. How does this mass compare to the masses of the other carts.
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Trial II: Colliding a cart with a wall

1. Place the Force probe on its side wedged in a pile of books so that it is at the
same height as the bumper of your cart. It could also be clamped to a ring
stand. Have someone hold the Force probe down firmly during the experiment.
Unscrew and set aside the larger eyebolt if it's in the way.

2. Make sure the motor and propeller are set for pushing the cart. The white dot on
the propeller should be toward the motor.

3. Connect the Force probe to your handheld computer. Refer to Technical Hints
to see how to connect the cables.

4. Start the software.

5. Set the force probe to zero in this position. Refer to Technical Hints to see how
to set the Force probe to zero.

6. Line up the cart bumper with the Force probe, then roll the cart back about
50cm. Mark the distance so that you can start the cart in the same place every
time.
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7. Start the propeller motor. Use the springiness of the wires to hold them lightly in
place.

8. Start recording the force, then let the cart go. Make sure it bumps directly into
the small eyebolt. Observe the behavior of the acrobat during the collision.

9. Stop recording immediately after a good collision and save your data to the
handheld computer.

10. Examine the graph. Zoom in on your collision until it fills most of your screen.

11. Answer the following in Notes on your handheld computer:
a. What is the shape of the graph?

b. How long did the collision take?

c. What was the maximum force?

d. What did the acrobat do during the collision?
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Trial III: Adding a bungee cord

1. This time you will try a "reverse" collision. You will measure the force on a
bungee cord attached to the air cart when it stretches and bounces back.
Connect the Force probe to your handheld computer. Refer to Technical Hints
to see how to connect the cables.

2. Place the Force probe on its side wedged in a pile of books so that it is at the
same height as the bumper of your cart. It could also be clamped to a ring
stand. Have someone hold the Force probe down firmly during the experiment.
Unscrew and set aside the larger eyebolt if it's in the way.

3. Cut a long rubber band to make a bungee cord. Attach one end to the Force
probe and the other end to the cart. Use several rubber bands if needed so that
the cord is about 1/2m long.

4. Line up the cart with the Force probe, with the rubber band lying loosely
between them. Hook things together with paper clips.
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5. Start the software. Start recording the force. Give the cart a push so that it
stretches the bungee cord and then bounces back. Catch it before it hits the
Force probe. Stop recording. Observe the behavior of the acrobat.

6. Try this several times, and after a good bounce save your data to the handheld
computer.

7. Examine the graph. Zoom in on your collision until it fills most of your screen.

8. Answer the following in Notes on your handheld computer:
a. What is the shape of the plot?

b. How long did the collision take?

c. What was the maximum force?

d. What did the acrobat do during the collision?
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Technical Hints

Connecting the Force probe

1. Connect the flexible cable from the Force probe to the Force probe card. Plug
the Force probe card into Port A of the Interface Box. Be careful not to bend any
of the copper prongs, or it won't work.

2. Attach the CCProbe Interface Box to your handheld with the Velcro square.
Connect the CCProbe Interface Box to your handheld with the provided
connector cable.

3. Tap on the CCProbe icon to open the software. Open or create a Force probe
data collector.
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Attaching the Force probe to the air cart

1. Remove the bumper and the acrobat from the front end of the air cart.

2. Set the Force probe on the cart, resting on the flat plate that has two threaded
holes in it. Mark the two holes on the cardboard with a pen or pencil.

3. Punch two holes in the cardboard with your pen or pencil. Enlarge them from
both sides so that a screw will just fit through.

4. Put the two screws first through the cardboard from the underside, and then
screw them into the Force probe plate. Tighten them until the heads squeeze
the cardboard a little bit. A paper clip will work as a screwdriver.

5. Unscrew the larger eyebolt and set it aside. Glue the bumper on the smaller
eyebolt.
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Setting the Force probe to zero

1. Connect the Force probe to the CCProbe Interface and open the CCProbe
software. Open a Force data collector. Hold the Force probe in the exact
position and orientation where you would like it to read zero.

2. At the bottom of the screen, click on the Tools menu.

3. Click on Zero Force Probe in the Tools menu.

4. The Force probe will be set to zero. Wait a few seconds and then go ahead with
collecting data.
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Using the CC LabBook software

To use CC LabBook just follow these easy steps!

1. Opening the software

a. To open the software, tap the CCProbe icon.

b. The first screen you see is the LabBook.

2. Opening folders and subfolders

a. The LabBook lists all of the folders, data collectors, notes, saved datasets,
and other objects in the LabBook. To open folders and subfolders, tap the
triangles or double-tap the folder name.
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b. Click Home (upper left) to go back to the top level folder.

3. Opening a data collector

a. To take data with a CC probe, you must open or create a data collector. In
these investigations, the data collectors have already been created.

b. To open an existing data collector, highlight its name, then tap it twice or
tap Open. It may take a few seconds for the graph to appear.

4. Collecting and clearing data
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a. To start collecting data, tap Collect.

b. As data is collected, the current values appear at the top of the graph. To
stop collecting, tap Collect again.

c. You can clear the data with Clear, and then continue collecting data with
Collect.

5. Reading graph values

a. To read values of a graph once it has been collected, tap on the Mark flag
and tap where you want to read the value.
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b. A little triangle will appear, connected to crossed lines. The mark can be
moved around with the cursor, and the x and y values of the graph will
show at the top.

6. Recognizing collection limits

Currently there is a limit to how much data can be collected at once, about
4000 data points. The collecting will stop when this amount is reached, so plan
your experiments with this in mind. In terms of time, the limits are as follows:

Force probe, 400/sec = about 7 seconds

Force probe, 200/sec = about 15 seconds

SmartWheel = about 40 seconds

All others 3/sec = several minutes

7. Scrolling around the graph

To scroll around the graph, tap and drag within the graph area itself. There
may be a slight delay before the graph responds.

8. Changing the scale of an axis

a. To change the scale of an axis, tap and drag on the region along the axis.
Drag away from zero to expand the scale and toward zero to shrink the
scale. There may be a slight delay before the graph responds.
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b. If you stretch or shrink the scale a great deal, it will switch by a factor of
1000, shown as 10^3 (for large numbers) or 10^-3 (for small numbers). For
example, in the following screen, time is in milliseconds (1/1000 of a
second) and light intensity is in kilolux (1000 lux).

9. Zooming in on the graph

a. To zoom in on part of a graph, tap on the area selector at the bottom of
the screen.

b. Drag the outline around the area of the graph you want to zoom in on,
then tap Tools.
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c. Click Zoom in the Tools list.

d. The graph will reappear showing just the area you selected.

10. Changing graph properties

a. To change graph properties, tap the Palm menu icon at the bottom left
corner, then the Edit menu item. Tap Graph Properties.
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b. To change the title, go to the Graph tab. Write the new title, and then tap
OK.

c. To change the range and the label of an axis, tap on the YAxis or XAxis
tab. Write in the Max, the Min, and the Label, and then tap OK.

d. Another method of changing the range and the label of an axis is to tap on
the ends of axes to open graph properties.
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11. Saving data

a. To save your data, tap the Palm menu icon at the bottom left corner. Then
tap Save Data in the File menu. The menu will disappear when the data is
saved. This may take several seconds.

b. When prompted, give your data set a name. It will be saved in your
LabBook.

12. Closing the data collector

To close the data collector and go back to the LabBook screen, tap Done.
Your data will NOT automatically be saved.
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Analysis

1. Compare the bumper event and the rubber band event. How long did each
collision take? What was the maximum force? What was the shape of the
graph?

2. What is the relationship between the behavior of the acrobat and the shape
and size of the force graph?

3. Why do you think the forces were different for the bumper versus the bungee
cord?

4. Consider riding on the cart. Which collision would you prefer, a collision with a
wall or a collision using a bungee cord? Why?

5. How could you decrease the maximum force when the cart hits the Force
probe? Explain why your idea would work.
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Further Investigations

• Use the SmartWheel to investigate the change in velocity during a collision.
Compare the wall collision with the bungee bounce. How is the change in
velocity related to the maximum force?

• Investigate collisions of the cart with the Force probe, putting varying masses on
the cart.

• Investigate the collisions of the cart with the Force probe, changing the distance
the cart accelerates before it hits.

• Investigate other collision conditions, such as, placing a lump of clay as an
additional bumper, stiffer or more elastic rubber bands, or holding the Force
probe more loosely so it can "give" a bit in the collision.
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